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This Guide will talk about the capabilities of ClamVision software as well as direct the user on how to
operate its functions. This guide discusses in detail ClamVision features and menus, not the fundamental
concepts needed to understand them.
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ABOUT

Information about the software and Cable Arm, Inc. can be found in the About menu. To access
the About menu click Help in the menu bar. Then click About.

B ClamVision - G\projects\BASP\BASF.clm

File Settings View Utilities Run | Help

Contents...

About...

The about will not be updated with the software. This guide will.

ADD/EDIT LINES

In ClamVision lines can be drawn on the work screen.
Open the Add/Edit lines window by clicking Settings from the
menu bar and then select Add/Edit Lines. The Add/Edit Lines
dialogue box appears.

8 ClamVision - GAtest-8-16-2007_13h10m36:

File | Settings | View Utilities Run Help
Dredge Setup...
Hardware Settings...

Map Projection... Enter the X and Y coordinate of the point that starts the line.

Click the space next to the asterisks to enter another point.
Import ]

Project Depth Setup...
Chainage/Offset

Add/Edit Lines...
Add Target at Point

Color Scales...

Preferences...
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Add / Edit Lines

® |y | Connect |
437369.228 F429660.425 v
4869607 R479702 689 v
437331131 F479727.195 r
437630 665 F475084 554 [v

» B 0 v

#

Points will be connected together until a point with an unchecked checkbox is encountered. The point
with the connect box unchecked is the start of a new line.

ADD TARGET AT POINT

At any time during work a target can be placed anywhere on the work screen. To add a target at
a point, double click the left mouse button on the work screen. A dialogue box appears. Label the target

Add TaEt_ and note the coordinate. Press OK to add the target to the work

Label: |4/15/2008 11:45 AM

screen. The target will look similar to the example below.

Location -;:I
A 489150848 o
Y. 5429978929 1y

243 H

[ OK | [ Cancel |

i
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Another way to add a target on the work screen is by selecting the settings menu from the
menu bar then click Add target at point.

4 ClamVision - CAUsers\HBEOMB\Desktop\Br

File View Utilities Run Help
Dredge Setup...
Hardware Settings...
Map Projection...

Import k
Project Depth Setup...
Chainage/Offset

Add/Edit Lines...
Add Target at Point

Color Scales...

Preferences...

AUTOTRACK

Use autotrack to have the work screen follow the vessel while moving. Without autotrack on the
vessel will move off the screen out of view. To turn on autotrack select the view menu from the menu
bar. Then click autotrack. A check mark will appear when turned on.

& ClamVision - CA\Users\HEOMB\Desktop\Broken key\test

File Settings | View | Utilities Run Help

Plan View

3D View

Bite Colors k
Teggle Layers J
Morth Up

Zoom Bdents
AutoTrack

Center on Point

Center Barge in Screen

Real-Time Cross Section 1... Page 6 of 45
Real-Time Cross Section 2...
Real-Time Cross Section 3...

ClamVision Software Guide D peratar’s Dats Vievis,

Timeframe...
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BACKUP FILES

We recommend that the job progress be saved and backed @ ClamVision - CAUsers\HEOMB\Desktop\B
up every day. Backup the current project file by clicking file Settings View Utilities Run Help
from the menu bar then backup. When the folder browser : I"-Jew = S|
comes up, select where on the computer or removable drive Open...
you want to store the project file. Click the Make new folder G
button to add a folder for the backed up project file.
Backup
Browse For Folder L&J I
Import Logs..
Backup Project Hide Logs / Change Phases...
Export
= Floppy Disk Drive (A2 & Print...
&, Local Disk (C)

. I8 DVD RW Drive (D:) Sid Meier's Civilization it
; E DVD Drive (E:) 5ins of a Solar Empire
= Mew Volume (F:)

o Permovable Disk (G:)

'_:," Metwark

“ Control Panel

m

£ Recycle Bin

Demlemm lrms s

Folder: Remavable Disk {G:)

Make Mew Folder | [ 0K, ]I Cancel

BITE COLORS

The bite colors menu allows the user to set the meaning of the bite colors. Bite color options
include depth based, distance to project, amount removed, and number of bites taken. To set the bite
colors click the view menu from the menu bar. Then mouse over bite colors. Select your preferred
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option from the menu box to the right. A check box will show to the left of the selected bite color

option.

[ ClamVision - C\Users\HBOMB\Desktop\Broken key\test-8-16-2007_13h10m36s\test.cim

File Settings | View | Utilities Run Help

v

Plan View

3D View

Bite Colors
Toggle Layers

Morth Up
Zoom Bxtents

AutoTrack

Center on Point

Center Barge in Screen

Real-Time Cross Section 1...
Real-Time Cross Section 2...

Real-Time Cross Section 3...

Operator's Data View...

Timeframe...

Depth Based
Distance to Project
Amount Removed

Mumber of Bites Taken

¥ Show "Made Grade"

Depth Based- colors will represent actual bucket depth. (Requires depth system)

Distance to Project- colors represents the distance from last bucket depth to final project depth.

(Requires depth system)

Amount Removed- colors indicate the number of feet of material removed in that particular area.

(Penetration based)

Number of Bites Taken- equals the number of cycles in one area.

Show “made Grade” — When bucket hits grade marking will produce red mark to show digging, or

capping, is done in that area.

ClamVision Software Guide
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Bite Viewer

The bite viewer allows you to look at the details of each bite mark on the screen. The viewed
mark turns yellow as you mouse over it. To open the bite viewer left click the Utilities menu from the
menu bar and select bite viewer. You can also delete unwanted marks from this menu. To delete a mark

R e e T e e e e e e left click the delete bites button at
File Settings View [Utilities| Run Help

Initialize Devices...
Lat/Lon - XY Calculator
Simulator

Cross Sections...
Excavator Configuration

Yolume Calculations

the bottom of the bite viewer. Left
click the bite you want to delete. It
will ask you if you’re sure you want
to delete this bite, if so click yes.

BiteViewer

Date: Monday, Apnil 28, 2008

Data Viewer... Time: 12:02:35 PM
Bite Viewer... 1 Depth: 34
Envirenmental Monitoring Graph Raw Depth: 34

Envirenmental Monitoring Gauges Tide: 0

Position log playback Center: 14,61, -60.80

[elete Bites

) ClamVision - CAUsers\HBOMB\Desktop\nicholson termi

File Settings [View]| Utilities Run Help

Center Barge on Screen

v Plan View
3D View This option places the barge in the
Bite Colors » | middle of the screen when the dredge cannot
Toggle Layers + | befound. This is useful during planning and
system configuration. This option will only
Morth Up

work if all devices are turned off. Access this
Zoom Extents option by opening the view menu on the

AtaTack menu bar and select Center Barge on screen.

Center an Point

Center Barge in Screen

Page 9 of 45
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Center on Point

Cable Arm, Inc.

This option centers the work screen on a specified point. The coordinate should be X and Y values.

0 ClamVision - C\Users\HBOMB\Desktop\nicholson termi
File Settings Utilities  Run  Help
v

Plan View

30 View

Bite Colors

Toggle Layers

Morth Up
Zoom Bdents

AutoTrack

Center an Point

Center Barge in Screen

Real-Time Cross Section 1...
Real-Time Cross Section 2...

Real-Time Cross Section 3...

Operator's Data View...

Timeframe...

Center On Point

n

Chainage and Offset

To setup Chainage/ Offset markers, select Chainage/Offset from the settings menu in

the menu bar. Station numbers and cut lines can be drawn on the work screen using

centerline and toe points. After using the tabs at the top of the Chainage/Offset dialogue

ClamVision Software Guide
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box to enter the coordinates for the center and toe lines, set the starting number of the first

station. Chainage increment is controlled by cross track separation. The first station will be

the first point entered. Use Offset/Chainage Point to set were on the barge the chainage and

offset readings will match. For Barges with three or less spuds may add a fourth spud and

use it as the Chainage/Offset point. To see station numbers cross tracks must be enabled.

To enable cross tracks left click the box next to enable cross tracks. The box will become

checked. This will put lines perpendicular to the centerline with station numbers at each

end. Set the distance between cross tracks and the width below. To enable Cut lines left

click the box next to enable cut lines. The box becomes checked. Enabling cut lines will

create lines parallel to the centerline. Select the distance between them and how many on

each side.
o5l Chainage/Offset

|_|:| (2] | “1

Centerine | Left Toe | Right Toe |

» | 13444277 932 234487 266
12444215788 234313.847

Start chainage: 250

Offset!Chainage Point:
IStar ‘&!\‘F came -

Cross Tracks

|#] Enable cross tracks
Cross track width 20

Cross track seperation 50

Imiport |

Cut Lines

[¥7] Enable cut lines

Cut Line seperation

Mumber of Cut Lines on
Left Toe

Mumber of Cut Lines on
Right Toe

&0

0K L

Cancel

ClamVision Software Guide
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Color Scales

ClamVision can display two color scales on the work & e E ATt e N e ol Te ] % LAY 01 i)

screen. The main color scale to represent the survey and File View Utilities Run He
design files and the bite color scale for bite mark colors. To Dredge Setup...

customize the color scales select Color Scales from the Hardware Settings...

settings menu in the menu bar. Map Projection

Main Color Scale
Toadda Import 3

color

0-0.5 - - i Add Project Depth Setup...
;ﬁ:ii;]l:ft 0.5 -1 -‘E | Chainage/Offset
Add 11-15 | R Add/Edit Lines...
button. Set the minimum and maximum values for the new Add Target at Point
field in the Edit Bite dialogue box. Left click the color bar to ColniBeilis.,
choose a different color. To edit an existing color range, left R e

click the Edit button and complete the Edit Bite dialogue box.
Automatically configure the color scales by setting the maximum depths, minimum depths and

the interval of display. A customized color scale can be saved to ;
Automatic

the hard disc and loaded into other projects. To save a color scale -
click save at the bottom of that scale. Then select a location on M |

the computer to store the file using the browser. You can also Maximum:  1g

copy one scale settings to the other by clicking the arrows in the : I
it :
middle. If the color bars are not displayed on the right side of the SR 5

work screen, check the Display on Main Screen box. To disable
the bite color scale completely, check the box next to Disable

Color Scale
Main Color Scale [ Disable seperate bite color scale [] Use suction dredge colors
1.05 - = | Add | Bite Color Scale
0.5-0 i Edit 0-1 [ A
A 1-2
0-05 [ | Ediit
0.5-1 E = s [ R J
1=l emove
1-1.5 | || Automatic |j 3-4 -|
s E | 4-5 i

1.5-2 £ | Minimum: g I =—— . | Automatic
2-25 = 5-6 - Minimum: g
25-3 Maximum: o

MMaximum:
3-35 Interval: g 0
3.5-4 Interval: o
4-45 Apply | e
4.5-5 l77| s Lot SRS
| 5-5.5 N - [#] Display on main screen W| W} [#] Display on main screen P

Save J | Load | = Auto update when project
! depth changed
OK Cancel |
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Separate Bite Color Scale.

Cross Sections

View bite, survey, post dredge, and design surfaces in a cross section. Under the
Utilities menu select “Cross Sections...” A blank Cross-Section Viewer will appear on the
work screen.

3 ClamVision - F\Projects\Densification-4-19-2008 10h42m26s\Densifica #d} Cross-Section Viewer

‘_:-HEI ]

itiali i =] oo =]
Initialize Devices...

Lat/Lon - XY Calculator

Simulator
Cross Sections...

Volume Calculations

Excavator Configuration...

Left click the Setup menu on the Cross Section Viewer and select “Edit Cross-Sections...” In the
cross section editor two coordinates that form a line from which to start the cross section. Or click the
Draw On Screen button to select two points on the work screen with the mouse.

Next select the number of cross sections you want to view and how far apart from each

- okl Cross-Section Editor | = | = [sE3s|  other they are.

The chainage numbers

First cross section’s coordinates .
will appear on the work screen

Point 1 to verify that the cross

A 483730.362152181 7! 5430166.1064725 sectioned area is correct. If the

additional cross sections are

spread in the wrong direction

Paint 2 check the Reverse Direction box.
X 48928543711665  Y: 5430132.82668011 Finally enter the starting

chainage and offset values so

the individual cross sections will

_| Reverse direction Draw on sereen be labeled correctly.

Mumber of sections: 10 Separation: 25
Page 13 of 45
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The user may also customize the cross section graph by setting minimum and maximum x and y
in view. The user can also set the step size of the graph as well as the shape of points. NOTE: All units
correspond with coordinate system units.

Cross Section Options = [
X adis
Minimum Maxamum
0 120
Step Size: 2 [¥] Show Grid
Y ais
Minimum Maxamum
-40 0
Step Size: ° [#] Show Grid
Point Symbal: b
N Ly
i ol Cross-Section Viewer | = | E |G T
Setup Export
(L= 5/25 [=
0+20
—<— Project depth —e— Bites Fost dredge dept)’1 ;
i —s— Survey depth ]

0 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 951001051101 15120
X Axis

Page 14 of 45
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Data Viewer

The data viewer is a customizable information box that shows on the work screen. Open it by

selecting data viewer from the Utilities menu in the menu bar. The Data viewer will display all possible
information in the window by default.

) ClamVision - C\Users\HBOMEB\Desktop\nicholson terminalnicholson 1
File Settings View fURIRES] Run Help

| Initialize Devices...
Lat/Lon - XY Calculator
Simulator

Cross Sections...
Excavator Configuration

Volume Calculations

Data Viewer...

Bite Viewer...

Environmental Monitoring Graph
Environmental Monitoring Gauges
| Pasition log playback
Multiple viewers can be displayed by repeating the steps for the first. Move them around on the
work screen by left clicking and holding the words Data Viewer at the top of the box. Right click the data

viewer to open the properties menu. In the data Barge X 2T 32 ‘
viewer setup box add, remove and edit fields. Use Barge " Fa2
the arrows in the middle to select field options from Boom X: Properties

the list on the right to move to the list on the left. EEETIL __E”fg__! ;

Any option listed on the left will show in the viewer.

Use the buttons in the bottom left to change the font, size, and color of the highlighted text.

Data Viewer [5]| o DataViewerSetup (=] E
Tlde: 0 [#- General
Draft: 0 Tide: = - Posttion
Bucket Depth: 0.0 : B o
Boom An I{; 000 fr [+~ Barge GPS Status
1o : Bucket Depth: - A GPS Satus
Clam Open: not open R 8- Cursor
Boom Angle: &+ Chainage
Clam Open: -~ Cycle Times
[#- Depths
[ Under Boom Tip
[~ Dredging Status

[ AddBresk | | Font | Enable Al
| Disabiel | (I

Page 15 of 45
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Dredge Setup

Dredge Setup is one of the most critical portions of ClamVision. Here you will setup the barge
and equipment that is being positioned by ClamVision. ClamVision is only as accurate as the information
put into it so be as accurate as possible. Use the same units to take measurements as has been set in
map projections.

Open the Dredge setup dialogue box by selecting Dredge Setup from the settings menu in the

menu bar. % ClamVision - C:\Users\HBOMB\Desktop
In the Barge tab, barge length, width, beam, and e @ Meumtriie S hnith
main GPS to port and bow are necessary fields. Unless two Dredge Setup...
GPS receivers are used, the Aux GPS to port and bow fields Hardware Settings...
are left zero. Map Projection...
The Dredge Cell/Scow tab lets you enter the Import 4
dimensions of the current scow in use as well as three others. Project Depth Setup...
Only one will show on the work screen. Chainage/Offset

Add/Edit Lines..,
Add Target at Point

Setting up a dredge cell is tricky but doable. You are
creating TWO BOXES on the work screen with the zero point
to the port-bow corner of the dredge. The offset X and Y is Eolor Sealec:
the measurement in feet or meters from the zero point. R e
Length and width is the size of the box.

In the Spuds tab enter as many spuds as needed. NOTE: a spud can be entered to set a chainage
and offset point on the barge. Also spuds can have unusual measurements to represent structures on
the barge.

The Crane/Clamshell tab is where you select the machine type and its place it on the barge. Fill
in all fields even though they may not pertain to the current system setup. Calibration of machines
sensors is done through hardware setup and excavator configuration. See configuration section of the
Cable Arm, Inc. installation guide for the calibration instructions.

Page 16 of 45
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Environmental Monitoring Gauges/Graphs

Environmentally sensitive projects are becoming more and more common in the dredging
industry. ClamVision offers features that allow its user to view specific environmental data on the work
screen. ClamVision will Bring in the data and transmit it to every machine onsite.

The pictures below demonstrate the different graphs and gauges available to monitor factors
such as temperature, conductivity, and water turbidity during a job.

Click Utilities, then the graphs or gauges as desired.

M ClamVision - C:\Project Files\test\test.dm

File Settings View [Utilities] Run Help

Initialize Devices...
Lat/Lon - XY Calculator

Simulator

Cross Sections...

Volume Calculations

Excavator Configuration...

Cable Counter Configuration...

/

Mo
1)
7

Silent Inspector Configuration...

Ib
<
&
N
f

F

Data Viewer...

Bite Viewer...

0z ELL ]
| Wy D0
0ZEEILL
M 000l
WEETILL
W O LL
0ZEZILL
Md 00zl |
WozrezL
| Wd 00l |
0L

Environmental Monitoning Graph

Environmental Monitoring Gauges

Position log playback

i

i,

'"uﬁénea}&'rr'\;lf-’{:i T iML2]  oriina 2“I'M|;-:31 e T IML-AI
6.8 NTU 10.1 NTU 7.8 NTU 16.2 NTU
DOV 00 A3 32 1.0 e 14 84 i 28
100% 100.0 149% 15718 115% 120.2 238% 496.9
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Excavator Configuration

Cable Arm, Inc.

The configuration of the excavator arms, tool, and position is done through this menu. The Real
time cross section window should be open while calibrating.

Click Utilities then Excavator Configuration.

# ClamVision - C:\Project Files\test\test.cim

File Settings View [Utilities| Run Help

Initialize Devices..,

Lat/Lon - XY Calculator

ClamVision Software Guide

Simulator
Cross Sections...

Volume Calculations

Excavator Configuration...
Cable Counter Configuration...

silent Inspector Configuration...

Data Viewer...

Bite Viewer...

Environmental Momitoring Graph

Environmental Monitaring Gauges

Position log playback

Page 18 of 45
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ol Excavator Configuration

Cable Arm, Inc.

=Rl X

Pressure Sensor

Pressure
sensor distance
up from end of
Armz

[] Fixed to barge

Depth

GP5 Location

GPS to Port
(Left)

o

GPFS to Front
1]

Am 1
Length
0

0

Angle
0 e

[ clockwise

Angle Offset | T

Trunion

Trunion height
above water

0

Trunion to port
P XY

0

Trunion to front

0

Am 2
Length
0

Angle Offset |3

0
]
Angle
0 =

[7] clockwise

Deck Angle
Angle Offzet

Deck Angle

[ clockwise

Am 3
Length
0

ingle Offzet |3
[
Angle
0 =

[7] clockwise

Buclet

) ClamShell

b1
12
0z
1
03
9

Auto marking
Clozed angle

260

DOpen angle
240
__ Nomarking

[¥] when above
witer

@ Backhoe style

01
1
b2
0
D3
i oy
D4
152
D&
1.23
Bucket Angle
110

EXIT

The program can be exited two different ways. The first way to exit ClamVision is to select Exit

% ClamVision - F\Projects\Densification-4-
Settings View Utilities  Run  Hely

Mew...
Open...

Save
Backup

Irport Logs..,
Hide Logs / Change Phases...

Export
Print...

Exit

under the file menu. The second way to exit the software is

to left click the red X at the top right corner of the screen.
IMPORTANT: All settings will be lost if the program is
exited without saving first. Data logged will automatically
save. Always save the current progress before closing

ClamVision software. The logs will automatically save but
settings that the user defines do not.
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Exporting Data

ClamVision allows you to export the data saved by the bite marks. This can be useful to create a

post dredge surface to compare with soundings and to view in other programs. Start by selecting Export

from the File menu in the menu bar. The save as dialogue box appears. Browse to the location on the

computer to store the data then name it. The data can be exported in four file types.

Computer

L

Metwork

1. Export as a bitmap (.bmp). This will save a picture of the work screen in the current project
folder unless specified elsewhere.
2. Exporting as a JPEG (.jpg) will also save a picture to the current project folder but in a different
format.
3. Export as a .DXF to view the data in AutoCAD or other design programs.
4. Export as a .XYZ file to have a surface model.
401 Save As I&J
Savein: richalson teminal ~ OF e M
b Name’ Date modif... Type
iu.;b? lo
Recent Places ] Select
location to

¥y

/’ store file

Name file

File name: job3 last shifts logs - l Save I

Save as type:

y

Select file type

XY Z File of bite comers and center poirts(™ xyz)
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Hardware Settings

The Hardware Settings section of the software may well be the most important part of the
ClamVision program. This section deals with settings that allow the hardware components of the
system to cooperate with the software. By choosing the correct settings for each piece of hardware
used, it allows the software to recognize and understand the data from the hardware and its specific

purpose.

For each hardware component, the first step is selecting the correct “driver” for the job. This
choice depends solely on the type of hardware being used. Secondly, a “com port number” needs to be
chosen to tell the computer where to expect the information coming in. Then the “baud rate” must be
set to tell the computer how fast to expect the information coming in. Finally, in some cases, an “offset
value” can be added to fine tune the hardware unit’s accuracy, see configuration.

The picture below will illustrate the steps above.

Click on Settings and choose Hardware Settings.

File View Utilities Run Hel|
Dredge Setup...

Hardware Settings...

Map Projection...

Import 4
Project Depth Setup...
Chainage/Offset

Add/Edit Lines...
Add Target at Point

Color Scales...

Preferences...
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[ g SetupWindow ﬂ

Plasii Position

Heazding

Boom fip position
Bucket Depth
Tude
OpenClosed

Marking

Draft

Other

The setup window above will appear and a specific item from the list on the left side of the screen can
be selected. From this point, the settings mentioned above can be configured.
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A “driver” must be selected from the available dropdown list.

o5l SetupWindow

Cable Arm, Inc.

Posilion

Heading

Boom tip position

Bucket Depth

Tide

Open/Closed

Marking

Diraft

Other

ClamVision Software Guide

Position

Disabled W
Disabled

Manual Position
Pos/Heading GP5
GPGGA Barge Pos
GPGGEA Odd Party

Send [

Pause
Listener
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A “com port” and “baud rate” can then be chosen.

od SetupWindow S |
B Position
Heading
Pos/Heading GP5 -
Boom tip position
Bucket Depth
COM port Baud rate

Tide Com] - 9600 v

Comi i
Open/Closed COM3 ifiset:

COomM4
Marking Egmg

COM?
Diraft
Cther

T = Pause
Send — Listener
0K | | Cancel

At this point, if the hardware has been installed correctly and the appropriate power is being
received, then hardware information should start to appear in the “listener” box toward the bottom of
the screen. In some cases data may not appear or be readable. If everything looks correct, then click
“OK” to exit Hardware Settings. Then Click File, Save to ensure your settings remain after the program
is exited.

Looking at the picture above, there are several other areas of Hardware Settings that may be
configured depending on the hardware in use. However, the same general procedures will apply
throughout this part of ClamVision.
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Hide Logs/ Change Phases

All bite logs can be removed from the work screen. Select Hide logs / change phases from the

File menu in the menu bar. @ ClamVision - C:\Users\HBOMB\Desktop\:

Settings View Utilities Run Hely

Mew...

Open...

Save
Backup

Import Logs...
Hide Logs / Change Phases...
Export
Print...
Exit
Name the log file for future reference. Left : click OK and

the logs will disappear from the work screen. The file will be saved in the current project folder. To view
the logs again see the “Import Logs” section of this manual.

g5 New Phase / Hide Logs l= EEf X

Old Phase name:

Log files will be moved to a folder with the name
sbove. Use Import logs to show logs again

g | Cancel
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Importing Background files

Survey files, design files, and drawings can be imported onto the work screen individually via the
import soundings and DFX menus or viewed in groups with the file manager. To import a single survey
file select Import Soundings in the import menu from the settings menu in the menu bar.

File View Utilities Run Help
Dredge Setup...

Hardware Settings...
Map Projecticn...

Import [ Import DXF...
Project Depth Setup... Import Soundings...
Chainage/Offset File Manager...

KAt i Import Post Dredge Soundings...

Add Target at Point Import Raster/Satellite imagery...

Color Scales...

Preferences...

In the Import Sounding dialogue box, use the browse button to find the file to be imported. To replace
existing soundings with new ones check the box next to erase existing soundings. If you are just adding
another file then make sure that the box is unchecked.

The max leg length value will adjust the spacing between points in which ClamVision will
extrapolate depths. The bigger the number the more filled in the survey will look. The sounding

reduction factor reduces the number of points used to display the survey.

Import Sounding

File Name:  C:\Users\HBOMB\Desktop\1-170 | Browse |
[#] Erase Existing Soundings
Max Leg Length: 200 (2« sounding spacing)

Sounding Reduction Factor; 1

| |k
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ClamVision will allow the user to view all imported files through the file manager. Select import
through the settings menu in the menu bar. Then click file manager.

File [Settings | View Utilities Run  Help
Dredge Setup... |
Hardware Settings...

Map Projection...

Import b Import DXF...
Project Depth Setup... Import Soundings...
Chainage/Offset File Manager...

AT L., Irnport Post Dredge Soundings...

Adcl Taiget at Paiit Import Raster/Satellite imagery...

Color Scales...

Preferences...

Use the add buttons at the bottom to add more files. Highlight the file in the window and click
remove to delete the file. When a file is removed, it is deleted permanently. A check next to the file
name means that the file will be displayed on the work screen. Files without checks are stored in
ClamVision but not displayed. Click Close to exit the file manager.

File Manager |@| ‘:

| SaugD7chl xyz
| Holland [ Fsort xyz

| AddDXF || AddSoundings | | Remove | Page 27 of 45
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Import logs

The Import logs option lets you retrieve logs previously hidden from work screen. This feature is
great for viewing work progress on computers in the office. To import a log file select Import logs from

the file menu in the menu bar. Choose the file to be % ClamVision - C:\Users\HBOMB\Desktop\
viewed in the windows browser then click OK. Settings View Utilities Run  Hel

Mew..,

Open...

Save
Backup

Import Logs...
Hide Logs / Change Phases...

Export
Print...

Exit

Lat/Lon Calculator

The Lat/Lon calculator is a tool to help convert between Latitude and Longitude and X and Y. The
calculator will accept decimal degrees or degrees minutes seconds for Latitude and longitude.
Remember to set the geodesy in the calculator for it is not connected in any way to the map projections
menu. As you enter data into the given fields to opposite fields will fill in automatically.

Geagraphic <-> XY Calculator |§|

Lat: 42.136917261446 ¥: 13444455553
Lon: -83.1826345137041 Y. 234370.863

Calculator Projection

Group = NADE3
Zone = Michigan South: 2113

Units = US Feet i G
Change

Enter either |atitude/longitude or XY,
others will update automatically Page 28 of 45

Use either decimal degrees oo
or OO MM 55.55 with a space between each group
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Map Projections

To set the project datum select Map Projections from the Edit menu. Use the drop down boxes
to set the basic projections.

I Map Projection Settings

@ Basic
Coordinate System: [N-'E'-DES v]
Zone: | Michigan South: 2113 -
Units: | US Fest =
IS Feet ‘

I.Fet

") Advanced Command Line

Saurce

Destination

[ Construction grid ] [ Ok ] | Cancel ]

CAUTION! The construction grid does not work with all formulas. Use at least one other test method
aside from the one provided to confirm accurate positioning.

NEW PROJECT

From the menu bar click FILE then NEW. Fill in the project name. Use the BROWSE button to
select a location on the computer to store the project file.

" Clam\Vision - C\Users\HBOMB\Desktop\
Settings View Utilities Run  Help

Mew...

The NEW PROJECTS Open.. dialogue box appears.

Save
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New Project

Project Name: |

Directory: Browse

@ Based on current project
") From Scratch

[C] Copy logs

oK ] [ Cancel |

Fill in the project name. Use the BROWSE button to select a location on the computer to store
the project file.

If using ClamVision for the first time, highlight the option button by clicking FROM SCRATCH.
Veterans of ClamVision can use previous settings by clicking BASED ON CURRENT PROJECT. Check the
box next to COPY LOGS to view logs from the last project in the current one. Click OK.

North Up

Selecting north up will orientate the work screen so that north is pointing towards the top of the
monitor. Find this option in the view menu.

¢ ClamVision - Ghcablearm\Work\Projects\test\test.clm

File Settings [View] Utilities Run Help
v Plan View
3D View

Bite Colors 3

Toggle Layers k

Merth Up
Zoom Bxents

AutoTrack

Center on Point

Center Barge in 5creen

Real-Time Cross Section 1...
Real-Time Cross Section 2...
Real-Time Cross Section 3...

Operator's Data View...

Tirmeframe... Page 30 of 45
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Open Existing Project

Open an existing project by clicking FILE from the menu bar then click OPEN.

# ClamVision - C:\Users\HEOME\Desktop\ Select a file stored on the computer or a removable
@ Settings View Utilities Run Help drive to open. The file will have an orange clamshell bucket
Mew... for an icon and a file extension of .cim.
Open...
Save

Operators Data Viewer

The operator’s data viewer displays information most important to the operator. Information
such as tide, bucket depth, survey depth, vacuum, and bucket status can be viewed in one location on
the work screen. To customize, right click the viewer and check the box next to the information you

want displayed.

OperatorsDataWindow &l
i ClamVision - Glcablearm\Work\Projects\test\test.clm
File Settings Utilities  Run  Help Tide Level: 0
v Plan View Operator's Display
3D View Font Size: 40
(Default = 40)
Bite Colors r
Toggle Layers k BUCkEt: 0 [] Target Depth
Morth Up [##] Bucket Depth
Zoom Extents | Tide
AutoTrack [7] Survey Depth
: Time: 11:51:06 [F] Current Depth
Center on Point : B amnent Flopt
: Bucket-Chainage: No
Center Barge in Screen Dredge-Chainage: Na ! [] Final Project Depth
Real-Time Cross Section 1... [] Bites Remaining -
Real-Time Cross Section 2... 7] Open/Closed Status
Real-Time Cross Section 3... i
| Vacuum
Operator's Data View...
| Boom Angle
Timeframe... .
| Sounder Penatration
[] Scunder Alarm
Alarm when sounder
penetration equals
]
ClamVision Software Guide
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Recent changes have been made that make this viewer obsolete. See Data Viewer. For

terminology, see ClamVision terms.

Plan View

For a 2D view of the work screen select Plan View from the View menu in the menu bar. This

will present the job area from a top view.

& ClamVision - G\cablearm\Work\Projects\test\test.clm
File Settings [Vﬂ\i Unti!i‘tyies” Run : Hglp’
¥ Plan View
3D View

Bite Colors 3

Toggle Layers k

Morth Up
Zoom Bxtents

AvdaTrarl

Position Log Playback

ClamVision allows the position of the barge and bucket to be recorded at a user defined interval.
Enabling this feature will create a “.pos” file in the current logs folder that can be later viewed using the
Position Log Playback menu option. USING THIS FEATURE WILL NOT AFFECT THE BITE LOG FILE IN ANY

WAY.

Enable Position Logging through the Preferences menu under Settings. Under the Position
Logging tab at the top check the box next to “position logging enabled” and set the logging interval in

seconds.

Preferences

| Data Viewer | Mode | Dredge Chainage | Postion logging | Turbidiy [ Ir <]
[ Position logging enabled Page 32 of 45
Logging interval:

(seconds)
ClamVision Softwi
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View the logged positions by selecting the Position Log Playback option in the Utilities menu. To
close the playback box click the red X at the top.

Postition log plé}.r

Current Time: "10/03/2008 03:20:01 PM' 12

Flayback speed

[ Play ][ Fause ]

Preferences

In addition to configuring ClamVision dredge setup, hardware settings, and map projections,
there is another area that requires attention before a job can commence. This section includes minor
features from font adjustment to more important ones such as dredging mode and water type.

-

To configure these preferences: Preferences

Display | Data Viewer I Mode lDredge Chainage | Position logging | Tul * | *

1. Navigate to the Settings menu.

DXF Font Size: 100
2. Click on Preferences.

<F Point Crosshair Size: (Must
. . be set prior to import)

3. Configure each tab according to present
. . oL . . Bucket Transparency: 200
job conditions and specifications then click i

OK. Zoom Faclor (Default 1.1) 11

Page 33 of 45
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Print
The print feature in ClamVision allows for printing of screenshots in portrait or landscape
orientations.

Settings View Utilities Run Help

New...

2. Click on Print.

3. Choose orientation and click print button. 0
pen...

Save
Backup

Import Logs...
Hide Logs / Change Phases...

Export
Print...

Exit

Project Depth Setup

Set grade parameters here. Without this set some information in ClamVision will not be
accurate.

To set up a project depth:
1. Navigate to the Settings menu.
2. Click Project Depth Setup.

3. From the Project Depth Setup dialog box, click either Dig To Fixed Depth or Remove Layer. A fixed
depth will leave a flat bottom unlike remove layer which keeps the contours of the bottom.

Page 34 of 45
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You can also import a design file. To do so, select the Browse button and navigate to the file’s
location.

Project Depth Setup

M ClamVision - C:\Project Files\test\test.dm
File | Settings | View Utilities Run Help

i@ Dig to Fixed Depth

Dredge Setup... @ Depth
Hardware Settings... =

Map Projection... © Import Surface
Import »

Project Depth Setup...
Chainage/Offset

(=) Remave Layer

Add/Edit Lines...
Add Target at Point

Color Scales...

Preferences...

Overdepth i} [ oK | [ e

Real Time Cross Sections

ClamVision offers three additional viewing windows that may be configured to show different
aspects of dredging.

To open an alternate viewing window:
1. Navigate to the View menu.
2. Click on Real Time Cross Sections.
3. Right click in this window to bring up a “properties” option and click on it.
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4. Use this window to configure the cross section view to best suit the job at hand.

Cable Arm, Inc.

% ClamVision - C\Project Files\test\test.dm

File Settings [View | Utiiiies Run Help
v Plan View
3D View

Bite Colors 3

Toggle Layers »

North Up

Zoom Extents
AutoTrack

Center on Point

Center Barge in Screen

Real-Time Cross Section 1. Real Time Cross Section

Real-Time Cross Section 2...
Real-Time Cross Section 3...

Operator's Data View...

Timeframe...

Blue = water.

Green = material to remove or place.
Yellow = material removed or placed.
Orange = over dredged areas.

Brown = point at which digging stops.

ClamVision Software Guide
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Save

‘@ ClamVision - C:\Project Files\test\test.cdim

@ Settings View Utilities Run Help ClamVision automatically saves logged

bucket data. However, it is necessary to save the

New... project manually when a setting is changed or a
Open... new file is imported.

Save ( To save a ClamVision project file:
Backup 1. Navigate to the File menu.

Import Logs... 2. Click on Save.

Hide Logs / Change Phases...

Export
Print...

Exit

Dredge Simulator

It may often prove helpful to simulate a dredging environment without an actual project
underway. The simulator can assist in presenting a completed project and in visualizing future
possibilities. It is also handy for testing and troubleshooting purposes.

To open the Dredge Simulator:
1. Navigate to the Utilities menu.

2. Click on Dredge Simulator.
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‘@ ClamVision - C:\Project Files\test\test.cdm

Cable Arm, Inc.

File Settings View | Utilities | Run Help

Initialize Devices...
Lat/Lon - XY Calculator
Simulator

Cross Sections...

Volume Calculations

Excavator Configuration...
Cable Counter Configuration...

Silent Inspector Configuration...

Data Viewer...

Bite Viewer...

Environmental Monitoring Graph

Environmental Monitoring Gauges

Position log playback

The simulator can be controlled by positioning the boom tip independently or by moving the entire

barge within the project. Bucket depth can also be manipulated, as well as its open/closed status.

Finally, marks can be placed on the screen to represent bucket bites within the simulation. Marks

created with the simulator will save to the project file as if it were done with the crane.

ClamVision Software Guide
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@ ClamVision - C:\Project Files\test\test.cim

File Settings View Utilities Run Help

Dredge Simulator | E
Boom Tip Postion Bucket Onertation
Movement Style. Boom/Swing (Buttons) [ Rotate Back ]

Step Distance: 2 feet | Rotate Forward |

Bucket Depth [ Dpen ]
o 0 (G ]
(¥

Bange Posttion Bucket Marks

Movement Style: Up/Down/L/R (Buttons) ~
Step Distance: 5 feet
= Mark Buckel
() (] (o] (3] [c4
[#]

Start/Restart Devices, Stop Devices

ClamVision is set up to receive data from several devices such as GPS units and a wide range of sensors.
Any devices connected to ClamVision may be stopped, started, or restarted with two easy steps.

1. Navigate to the Run menu.
Page 39 of 45
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2. Click Start/Restart or Stop devices.

@ ClamVision - C\Project Files\test\test.cim

File Settings View Utilities Help
Start/Restart Devices

Stop Devices

Start Logging

Stop Logging

Start/Stop Logging

ClamVision is a versatile dredging program. This is demonstrated clearly in its ability to be used
in excavators as well as clamshell rigs. Certain applications may call for the ability to mark digging bites
in a continuous manner.

To achieve this, the user can start and stop logging according to preference.
1. Navigate to the Run menu.

2. Click Start or Stop Logging.

File Settings View Utilities [Run| Help
Start/Restart Devices

Stop Devices

Start Logging

Stop Logging
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Timeframe

The Timeframe feature in ClamVision allows for the user to view data from a specific “snapshot”
in time.

To view a particular timeframe:
1. Navigate to the View menu.
2. Click on Timeframe...

3. Enter the beginning and ending dates and times for the timeframe desired. Click OK.

This screen shows several days of digging. Bucket bite logs are visible near the bottom of the screen.

ji ClamVsan O\ rojc

1 [ 2SS TN SEO M
Fic Scttings View Utiltics Run  bdz

'*%Iilrlrrlilliﬂilll.
=T gy

Click, View, then Timeframe. A box will appear that will allow you to choose a specific date and block of
time during that day to view the bites that were taken.
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Click SHOW ALL BITES to return all bite marks taken to the screen.

Toggle Layers

Once a DFX or sounding file has been imported into ClamVision, it may be necessary to remove
unwanted layers or details from the project to enhance visual clarity. ClamVision offers a
comprehensive list of details or layers that can be displayed or hidden from the screen.

To alter the level of detail on screen:
1. Navigate to the View menu.
2. Click Toggle Layers.

3. Select details to show or hide. These details are listed below.
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Cable Arm, Inc.

This screen shows a sounding file as well as a dxf file. By using the Toggle Layers feature, only
the desired layers may be viewed at one time. Now, clicking View, then Toggle Layers and choosing

sounding layer to omit, we now see only the dxf drawing file.

File Settings [View) Utilities Run Help

v Plan View
3D View

Bite Colors
Toggle Layers

North Up
Zoom Extents

AutaTrack

Center on Point

Center Barge in Screen

Operator's Data View...

Timeframe.

Survey Surface
Project Surface
Bite Log

Bite Log Lines.
DXF Lines

DXF Labels

Anchors

Real-Time Cross Section L.,
Real-Time Cross Section 2..,

Real-Time Cross Section 3...

o (T B e e B
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Zoom Extents

Cable Arm, Inc.

Zoom extents will center the imported files on the work screen. When ClamVision is turned on

without GPS input, it places the rig in the last known location. Use zoom extents to view imported files

when there is no GPS input. If GPS input is present, stop the devices through the run menu.

NOTE: When projects in different locations are imported at the same time, zoom extents will not work.

It will put you somewhere in the middle.

Select Zoom Extents from the View menu in the menu bar.

0 ClamVision - B\cablearm\Work\Projects\testitest.clm

File Settings [View| Utilities Run Help

v

ClamVision Software Guide

Plan View

30 View

Bite Colors

Toggle Layers

Morth Up
Zoom Bxtents

AutoTrack

Center an Point

Center Barge in Screen

Real-Time Cross Section 1...
Real-Time Cross Section 2...

Real-Time Cross Section 3...

Operator's Data View...

Timeframe...
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3D View

By navigating to the View menu and clicking 3D View, the user can switch the project screen
from a plan view to a 3D view. By holding the wheel mouse button, the work screen can be moved asa 3
dimensional object.

o

ok

e

3D VIEW

plan view _ of4s
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